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The philosophy of iwrite.4.life  
The iwrite.4.life system is a toolset designed to satisfy all your journal keeping needs. There seem to 

be as many ways to keep a journal and as many things to store in a journal as there are people 

writing journals. Some stick to plain old paper and pencil, some use word processing software, some 

may use specialized journal writing software. All these methods have their advantages and 

disadvantages. So how would we design a system that fits as many journal keeping approaches as 

possible? 

To answer that question let’s first look at some of the benefits that we can potentially get from 

writing things up and keeping them in a journal. I believe two of the most important benefits of a 

professional journal are an improved process of learning and a more efficient approach to routine 

tasks: 

¶ Sometimes the mere process of writing about a problem helps finding a solution. When 

writing this software, for example, we often encountered bugs. Frequently, the causes of 

these bugs seemed impossible to find and many involved some piece of third-party software. 

It always helped us to write up a structured problem description and being forced to 

communicate with our partners’ support in writing was always instrumental in diagnosing 

the problem and finding a solution.  

You may say this doesn’t justify keeping a journal. However, we found that we were making 

the same (or similar) mistakes over and over again. By keeping the descriptions of problems 

already encountered in a journal we were able to diagnose problems more quickly or to 

avoid them altogether by occasionally browsing our old problem descriptions. 

¶ 5ƻƴΩt reinvent the wheel - While there are many more reasons why professionals keep 

journals (e.g., to prove what has been agreed upon) I believe the "don't reinvent the wheel" 

aspect to be one of the most important ones. As a modern professional, you are constantly 

solving problems. Some are small; some are bigger. Some are challenging to solve, as they 

require you to mobilize all your creative potential; some are boring but the solution is no less 

important.  

The truth is that we would all like to deal with just the creative and enjoyable stuff, but too 

much of our time is taken up by the repetitive procedures we can't ignore. That's the area 

that needs to be fixed in writing: Solved once and for all! So next time you'll just look it up 

and do it. The best candidates for this "programming yourself" (because what you write up is 

nothing but a program that you’ll execute to solve a known problem) are those tasks that are 

mildly difficult and occur intermittently. Inevitably, the exact moment you forget how to do it 

will be just before the problem creeps up again! 

Here are just two examples of this category of benefit: 

o Pack lists 

o Check lists 

For a private journal, there are probably many more different uses and, therefore, potential 

benefits than for a professional journal. Two benefits of a personal journal are: 

¶ If you’ve ever spent an evening with a shoebox full of old photos, reminiscing in fond 

memories, you may have wished you had taken some notes back then so you still knew who 

that person in the background is or where the picture of that gorgeous view was taken. 
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¶ If you’re trying to achieve a personal goal like reducing your weight, increasing your fitness, 

or controlling your expenses you need to set intermediate goals that are not too hard to 

achieve and lie not too far in the future. Like any “goal-seeking system” you’ll only stay on 

track if you have permanent feedback loops and that, in turn, requires you to write: You 

need to write up what your goal is, what the plan is to achieve it; and once you’ve started on 

the journey, you need to keep track of your progress. If you never tried it you may find it 

hard to believe what a difference in motivation it makes if you keep a record. The point is not 

to work out elaborate plans; the point is rather to establish a daily routine of quick record 

keeping of the exercises you did, or your weight, or your expenses, or whatever it is you’re 

trying to control or to improve. 

In summary, by keeping a professional and/or private journal you may reap the following benefits: 

¶ Save time 

¶ Learn 

¶ Reduce boring work 

¶ Achieve goals 

¶ Have fun (memories) 

¶ Leave a trace (memories again) 

So what do you need for successful journal keeping? 

¶ Mindset 

o “I write  things up because (structured) writing forces me to think a problem through 

and helps me find a solution.” 

o “I keep written-up stuff in a journal because I’d rather use my brain for dealing with 

new and unforeseen situations in a creative way instead of reinventing the wheel all 

the time. ‘Writing and keeping’ is an investment: it saves me more time in the future 

than I have to spend today.” 

o “I write about the future (aka as planning) not because I believe that reality will 

unfold exactly as to my plan but because planning helps me to deal better with the 

unforeseen.” 

o “I write about the past because it’s fun to indulge in memories and I want to leave a 

trace for myself and others.” 

o “When all this journal writing becomes a burden I give myself a break. When the 

break has taken long enough I go back to work ;-)” 

¶ Techniques 

o Learn 10-finger typing 

o Get organized (One approach I would recommend is called GTD) 

¶ Tools 

o Pencil and paper or maybe iwrite.4.life 

 

… And what’s this 4.life stuff all about? 

First of all, it’s all about the mind set of committing to it for the long run. I believe that’s much more 

important than using this tool (or any other). But as an aside: If all this writing and record-keeping 

becomes too much of a burden and you can find no fun in it whatsoever, then you probably 

http://www.rightmindlogic.com/resources/resources.html#GTD
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shouldn’t do it. Most likely, it’s a certain type of character that’s attracted to journal keeping. You 

may want to have a look at the MBTI® (Myers-Briggs Type Indicator) to learn about one system of 

classifying character traits and come up with your own hypothesis of which types likely tend to keep 

records and which don’t. 

Second, it’s to remind us that there is more than one dimension to journal writing. We can benefit in 

all areas of life from keeping written records, be it about the things we eat, the exercise we do (or 

don’t), things we need to do, goals we want to achieve, errands we have to run, how we solved a 

recurring task in the past etc. 

Basic concepts in iwrite.4.life : About journals, users, items, plugins, 

and tools  

Journals 
In iwrite.4.life anything that is worth keeping is kept in journals. Some journal writers keep just a 

single journal while others keep separate journals.  

¶ For example, you could keep a professional work journal and a private journal.  

¶ You could keep one journal per project if the projects you are responsible for generate lots of 

data that you want to store.  

¶ Each family member could have her own journal and so on. 

Basically, anything that can be turned into bits and bytes can be stored in an iwrite.4.life journal: 

text, images, video clips, and audio files (although the basic iwrite.4.life system is not optimized to be 

a multimedia database for large numbers of non-text objects). 

Users 
You can have as many users per journal as you like. Users can have separate passwords (or no 

passwords if they prefer) and they can have different access rights assigned by the owner or 

administrator of the journal. 

When you create a new journal it has just one user called owner with no password. The access level 

of owner is – you guessed it – owner. A journal’s owner can do anything he pleases including deleting 

other users’ entries or taking away access rights or changing users’ passwords. It might be a good 

idea, therefore, to assign a password to owner as soon as you create a new journal. It may be an 

even better idea to remember this password very well or even better, to store it in a safe place. 

The other access levels are admin, write, read, and none. None has the limited use of taking away all 

rights from a user (maybe temporarily) without deleting anything. This poor soul could then not even 

read her journal items. 

Admin can do anything the owner can, except delete a journal. In practice this does not really make a 

difference because a journal file can always be deleted on the operating system level. However, 

iwrite.4.life makes sure that at least one user with owner access rights always exists per journal so 

you cannot accidentally delete all users in which case you could no longer access your journal. The 

owner role may also be needed for further extensions of the access system. 

http://www.rightmindlogic.com/resources/resources.html#Myers-Briggs_Type_Indicator
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User names can be changed any time but a user can only change her own name unless she has 

logged on with admin or owner rights. The same user name can occur several times with different 

access rights and passwords. If that’s the case this user can see all her entries but can only modify 

those that have the same or lower access rights than the access right she currently is signed on with. 

Note that the user names “owner” and “admin” are not relevant for granting owner and admin 

access rights. The names are arbitrary and can be changed; it’s the access rights of a user that count. 

Journal items  
Journal items are the molecules in the iwrite.4.life universe. You can think of journal items as journal 

entries or individual documents although journal items don’t necessarily have to be text-based. 

Each journal item automatically gets a date and time stamp the very moment it is created and you 

can browse through your journal chronologically. You also see at a glance which days have any 

journal entries at all. 

To further help structuring the information you keep in your journal, each journal item is assigned a 

Topic and an InfoType. Topics and InfoTypes don’t have a fixed meaning in iwrite.4.life; consider 

them the equivalents of cabinets and drawers or folders and files or shoeboxes that contain smaller 

boxes. iwrite.4.life does come with lists of pre-defined Topics and InfoTypes but this is only for your 

convenience and represents just one way of interpreting what Topic and InfoType can mean. Nothing 

keeps you from extending or even replacing these lists with your own labels.  

If you look at the built-in lists you see that they interpret a Topic as a category or theme an item 

belongs to while an InfoType is viewed as the kind of information of the journal item. 

Pre-defined Topics: 

¶ How To... 

¶ Favorites 

¶ Projects 

¶ Weekend Trips 

¶ To Do 

¶ Ideas 

¶ Done 

¶ Info 

¶ Literature 

¶ PC Log 

¶ Quotes 
 

Pre-defined InfoTypes: 

¶ Phone Call 

¶ Minutes 

¶ Conversation 

¶ Journal Entry 

¶ Clipping 

¶ Note 

¶ Email 

¶ Document 
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You can also set default values for Topic and InfoType per user and journal. This is handy if a user 

mostly uses the same Topic and InfoType over and over again. 

Finally, there is the ItemType of a journal item. The ItemType describes the plugin that is used to 

create and edit the item. Out of the box, iwrite.4.life comes with one plugin, the ƛǘŜȄǘϰ text editor. 

Therefore, unless you buy additional plugins, all your journal items will have the same ItemType of 

itext (internally represented not by its “pretty name” itext but by a unique ID code). 

If you do get additional plugins, iwrite.4.life will automatically know about them and be able to use 

them once they are installed. You may want to check our website occasionally to see if new plugins 

have become available that might be of interest to you. 

Plugins 
If iwrite.4.life is a system for storing and navigating “molecules” called journal items then plugins are 

the instruments to create and modify those molecules. Each type of molecule has its own specialized 

instrument that knows the internal structure of the molecule (whereas iwrite.4.life does not). On the 

other hand, the plugins couldn’t care less how iwrite.4.life goes about storing the items as long as it 

keeps them safe and sound. 

It is this plugin architecture that I believe holds the most promise for the future of iwrite.4.life and it 

is one of the reasons why it carries 4.life in its name. 

The one plugin that is packaged with the iwrite.4.life system is the ƛǘŜȄǘϰ text editor. It has basic text 

editing and formatting capabilities and it may be all that you ever need for journal writing. If you 

need fancier layout and formatting features you can try the ƛǿǊƛǘŜϰ word processor. 

And, of course, further plugins will be coming. 

Tools  
While plugins are for molding the molecules in your journal, tools are for moving around in your 

journal. That’s why they’re all grouped in the Journal Explorer on the left side of the main window. 

The plugin architecture of iwrite.4.life applies not only to plugins per se but also to tools: New ones 

will be coming and you can just plug them into iwrite.4.life if you want. If you try them and find 

they’re of no use to you just forget about them. You don’t use them – you don’t pay for them. 

http://www.rightmindlogic.com/products/products.html
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How the  iwrite.4.life  system works  
This is the iwrite.4.life framework with a journal opened (see title bar) but without any plugin, i.e. no 

journal item opened or created yet: 

 

This is what the ƛǘŜȄǘϰ text editor looks like when plugged into the iwrite.4.life system: 

 

Plugin modules appear in this Work Area 

The user’s 

access rights 

The user name 

The open journal 

Menu and toolbars of the plugin 

Menu and toolbars of the iwrite.4.life host 
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The text in this journal item comes from the journal AlaskaWoman (A test journal provided at our 

website) as you can see in the title bar. It was created on Tuesday, May 04, 2010 (or rather it was 

created as an entry for this date – its actual creation date could be different). The Topic assigned to it 

is Topic 3, its InfoType is InfoType 8 and its assigned time of day is 11:41:52. 

How journal items are o rganized in iwrite.4.life  
Items you create with the ƛǘŜȄǘϰ text editor are stored within iwrite.4.life and, like all items, are 

organized by date, time of day, topic, and information type (called InfoType in iwrite.4.life) as you 

can see in the following image: 

Tools occupy this 

area - The Journal 

Explorer™ 

http://www.rightmindlogic.com/resources/test_data/AlaskaWoman.zip
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Reference 

Menus and Toolbars  
The menu bar shows the major object types you’ll work with in iwrite.4.life (like Journal, Day, Topic, 

InfoType, and Item). The individual menus contain the available actions per object type. On the other 

hand, the Command Toolbar shows action types (like Create, Delete, Modify, etc.) and the little arrow 

next to each action will let you choose which object type to apply the action to. 

In many cases you can also access the commands from a context menu by right-clicking an element 

in the user interface (a tab for example). 

The following images of menus and toolbars were taken immediately after the start of iwrite.4.life 

when no journal was open yet. All buttons and menu items that require a journal to be open are, 

therefore, grayed out. 

 

1: The item’s date – A 

day can contain any 

number of topics. 

2: The item’s Topic – A 

Topic can contain any 

number of InfoTypes. 

4: The item’s 

time of day 

3: The item’s InfoType – An 

InfoType can contain any 

number of time stamped 

items. 
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Journal Menu  

 

 

View Menu 

 

 

Day Menu 

 

 

Create, open, and 

close journals 

Save the open journal or save 

it under a new name (Save 

Journal As…) Print the complete journal 

(May take a long time!) 

Make a versioned backup copy of a 

journal; restore a previous version of a 

journal; Export or import journal items A list of recently 

opened journals 

Toggle display of status bar, Journal 

Explorer, Month Calendar, Journal 

Content, and Full-Text Search 

The active day is the day 

currently displayed; a 

selected day is a day you 

choose from a dialog. 

Moving a day means changing 

the assigned date of its journal 

items. It’s like moving all 

journal entries of a day to a 

different date. If an identical 

item exists at the target date, 

the corresponding item is not 

moved. 
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Topic Menu  

 

InfoType Menu  

 

 

Item Menu  

 

 

Navigation Menu  

 

Active = currently displayed 

Selected = you choose from a dialog 

Active = currently displayed 

Selected = you choose from a dialog 

Creating an item is like creating a document of a certain 

type; with a certain Topic and InfoType; and with a certain 

date and time. 

Modifying an item does not touch its content but allows 

you to change any of the attributes Topic, InfoType, date, 

or time. 

Use the „transport controls“ for 

date-based navigation in the journal 
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Tools Menu 

 

The menu items of the Tools menu are described below: 

For an explanation of the concept of users see Users. Note that you need to click the little 

Plus sign next to a user row to enter this user’s default Topic, InfoType, and ItemType. Unless 

you buy additional plugins, the only available ItemType will be iwrite.4.life standard text 

editor (The itext plugin). 

The Navigation Options determine the behavior of 

iwrite.4.life if you try to navigate to a journal item 

that does not exist.  

The Browse Options determine if a new tab is created 

for every item you create or open or, alternatively, 

the current tab is used for displaying the new content. 
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An optional email address can be entered on the User 

Administration Dialog. If you select this checkbox the 

address will automatically be validated. You can choose 

whether to check only the syntax, look up the address on 

the Internet, or try to connect to verify a functioning 

mailbox. 

Check this box to compress the 

journal database every time the 

program exits (This will slow down 

the exit process). 

Check this box to log the program’s 

error and warning messages. If there is a 

non-empty log when the program quits 

you will be asked what to do with it. 

Reset the user 

interface to the 

default 

arrangement of 

toolbars and 

menus. This 

option takes 

only effect after 

a restart of the 

program. 

Log on to the open journal as a different user. 
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Help Menu 

 

 

Minimize the program window and lock it. Enter 

password to regain access to the program. 

(Re)build, compress, or delete the full-text search index. 

These functions will not normally have to be executed 

by the user because iwrite.4.life automatically builds 

and updates the index. 

Access various pages on the Right Mind Logic 

website. 

Open the iwrite.4.life documentation 

Program’s About dialog. Use 

to find the program’s version. 
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Command Toolbar  

The Command toolbar is shown here in its floating state. The drop-down menus contain the same 

commands you find on the menu bar described above (Menus and Toolbars) except that the 

Command toolbar shows actions (like Create, Delete, etc.) on the top level whereas the menu bar 

shows objects (like Topic, InfoType, etc.) on the top level. 

 

Configuration Toolbar  

The Configuration toolbar is shown here in its floating state. It offers the same functions that are 

described under Tools Menu. 

 

Navigation Toolbar  

The Navigation toolbar is shown here in its floating state. It offers the same functions that are 

described under Navigation Menu. In addition, you can directly enter a date (or select one from the 

drop-down display) to navigate to in the date selector. If no item is open the date selector displays 

the text (No active date). 

 

Work Area  
The Work Area is empty if no journal item is open. Once you open or create a journal item, the 

toolbars and menus that appear in the work area depend on the type of item opened (the item’s 

ItemType). For example, if you create a new item of type itext, the user interface of the itext plugin 

will appear in the Work Area. If you browse existing items, iwrite.4.life will automatically open the 

correct plugin for the active item. Please note that only items can be displayed for which the correct 

plugin is installed on the local computer. If you never switch computers this is not an issue for you 

but let’s say you own iwrite.4.life plus several additional plugins you bought and you want to view 

your journal on a computer that only has the standard version of iwrite.4.life installed (with only the 

itext plugin). In that case you could obviously not view any items that you had created with any 

plugin other than itext unless you installed the required plugins. 
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Plugins  

iÔÅØÔΆ 

The itext work area is where you enter and format text. It is framed by a horizontal and a vertical 

ruler (If set to be displayed on the View menu). 

 

Horizontal and Vertical Ruler  

The rulers shown below are displayed in Page Layout view. If itext is in Draft view the page margin 

indicators will not be displayed. 

 

 

 

 

 

 

Change type 

of tab stop 

Set left paragraph 

indentation (top triangle sets 

indentation of first line only) 
Set right paragraph 

indentation 

Set tabs by 

clicking the 

mouse; remove 

them by dragging 

them away from 

the ruler 

Set left page 

margin 

Set right 

page margin 
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Menus 

 

File Menu 

 

3ÁÖÅ )ÔÅÍ !Óȣ 

The iwrite.4.life system saves items automatically when you exit the program or when you close a 

day tab. In addition, you can turn on the time-based Auto-Save function in iwrite.4.life if you like. 

Therefore, you will need the {ŀǾŜ LǘŜƳ !ǎΧ function only if you want to export an item in order to 

edit it in some other program or if you want to send it to someone. 

If you do select {ŀǾŜ LǘŜƳ !ǎΧ, a standard Windows Save As dialog will be displayed where you can 

select the location where you want to save the item as a file. You have a choice of formats as you can 

see from the following screen shot: 

Set top page 

margin 
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0ÁÇÅ 3ÅÔÕÐȣ 

The tŀƎŜ {ŜǘǳǇΧ menu item displays a dialog where you can modify the page layout of your itext 

item: 

 

0ÒÉÎÔȣ 

The tǊƛƴǘΧ menu item displays a standard print dialog: 



iwrite.4.life™ manual 

© 2011 Right Mind Logic, Wolfgang Braun. All rights reserved.  20 

 

0ÒÉÎÔ 0ÒÅÖÉÅ×ȣ 

The tǊƛƴǘ tǊŜǾƛŜǿΧ menu item displays the itext item as it will appear when printed. You can also 

print the item from the tǊƛƴǘ tǊŜǾƛŜǿΧ dialog. 

 

Edit Menu 

 

The menu items on the Edit menu are self-explanatory: They behave as in every word processor. 
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View Menu 

 

The iwrite.4.life itext editor offers two different ways of viewing the text: In Page Layout view all your 

formatting will be applied to the text and the page layout will closely resemble the printed version, 

whereas in Draft view you will only see a rough draft of the final version. Draft view was originally 

introduced in word processors when computers were much slower and it might have taken too long 

to always render all formatting. With modern computers you will rarely need Draft view for 

performance reasons. Nevertheless, when you create a new item, it will initially be displayed in Draft 

view. 

You can also decide whether you want to see the toolbar, status bar, and the horizontal and vertical 

ruler. 

Finally, you can change the zoom factor (between 25% and 300%). 

 

Format Menu 

 

On the Format menu you find the tools to change the character and paragraph properties of text. 
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#ÈÁÒÁÃÔÅÒȣ 

 

Changes you make on the Character or Font dialog apply to selected text and to text you type after 

you make the changes. 

You can select a font from the list of fonts installed on your computer and you can change the size, 

color, background color (“text marker color”) and the other attributes you see on the dialog above. 

0ÁÒÁÇÒÁÐÈȣ 

The Paragraph dialog has two tabs:  

¶ Formatting and Indents 

¶ Frame and Page Breaks 

The changes you make apply to the currently selected paragraph and to all text you type after you 

made the changes. 
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The Formatting and Indents tab contains all the typical paragraph attributes that allow you to 

arrange paragraphs of text on the page: 

¶ Alignment determines how the paragraph’s words are arranged in relation to the 

paragraph’s bounding rectangle (left, right, centered, justified) 

¶ Indents attributes arrange the paragraph in relation to the page margins; Special determines 

the position of a paragraph’s first and next lines relative to each other (none, hanging, first 

line). 

¶ Distances arranges the paragraph in relation to the preceding and following paragraph 
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The Frame properties let you choose a visible bounding box around paragraphs. 

The Pagination properties let you specify whether you want to keep selected lines together 

(automatic pagination will not separate them with a page break); you want to enforce a page break 

before the selected lines; or you want selected lines to be kept with the next paragraph (e.g., an 

image the text is related to). 

The Widow/Orphan control is a feature that will prevent single lines of paragraphs from appearing on 

a separate page from the rest of the paragraph (a widow is the first line of a paragraph left by itself 

and an orphan is the last line left by itself). The Widow/Orphan control will automatically keep two 

(or as many as you specify in lines) lines together on a page, shifting them as necessary when you add 

or take text away from the document. 
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Help Menu 

 

The Help menu lets you access the help system of itext starting on the Contents, Index, or Search 

page respectively. 

Toolbar s 

 

Drop-down boxes 

Paragraph Styles 

 

The Paragraph Styles drop-down box has only limited functionality compared to a more full-fledged 

word processor. You can use it to reset the selected paragraph’s font and font size to the default 

style (Arial 10) by selecting [Default Paragraph Font] from the drop-down box. 

Fonts 

 

The Fonts drop-down box will display the fonts available on your computer. The selected font will be 

applied to the selected text. 

Font Size 

 

The selected font size will be applied to the selected text. 

Zoom 

 

You can select a zoom factor between 10% and 400% from this drop-down box. 

Buttons 

Bold 

Clicking this button formats the selected text bold. 

Italic 

Clicking this button formats the selected text italic. 
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Underline 

Clicking this button formats the selected text underlined. 

Left-aligned 

Clicking this button formats the selected paragraph left-aligned. 

Right-aligned 

Clicking this button formats the selected paragraph right-aligned. 

Centered 

Clicking this button formats the selected paragraph centered. 

Justified 

Clicking this button formats the selected paragraph justified. 

Bullets 

Clicking this button formats the selected text as a bulleted list. 

Numbered Lists 

Clicking these buttons formats the selected text as a numbered list or a structured numbered list, i.e., 

a numbered list where. 

Show/Hide Special Characters 

If you click this button the end-of-paragraph characters will be displayed. 

Tab Stops 

The tab stop button has the identical functionality as the tab stop button on the horizontal ruler. You 

can use it to change the type of tab stops when the horizontal ruler is not displayed. 

Status Bar 

 

 

 

 

 

 

 

Insertion 

mode 
Column Line CAPS lock 

indicator 
Message area 

NUM lock 

indicator 

Current 

zoom factor 

Current page / 

Number of pages 
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Tools  
The Journal Explorer™ is not a tool but the container for all iwrite.4.life™ tools. Out of the box it 

docks to the left window margin but you can "tear it off" and place it wherever you want. This gives 

you a lot of flexibility to adapt the screen layout of iwrite.4.life to your personal preference. 

 

Month Calendar  

A free tool that is included in the iwrite.4.life™ setup 

package, the Month Calendar tool is a great way to see 

the days that have journal entries at a glance. You can 

then navigate to your entries with a single mouse click. 

Many journal writers find it quite motivating too to have 

an immediate visual representation of their journal 

writing activity or (inactivity) over time. 

Depending on your screen size and your personal work 

style, you can adapt the dimension of the calendar as 

you see fit. View just a single vertical column to save 

space; maybe even reduce the calendar display to a 

single month. Or, on the other hand, dock the Journal 

Explorer to the bottom of your screen and make the 

Month Calendar four or five rows high and you'll have an 

overview of three or more years of journal writing. 

 

 

Journal Content  

Another free tool included with iwrite.4.life, the Journal Content tool is a structured table of 

contents of all your journal items. You see your journal items sorted by Topic, InfoType, and date. 

Best of all, you can change the sort sequence any time.  

 

 

 

For example, you may want to have the items sorted by 

InfoType first, date second, and only then by Topic. And of 

course you can name and rename all your Topics and 

Use this slider to adjust the 

height of the active tool (in 

this case the Calendar) 

Use this button to 

sort the table of 

contents 
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InfoTypes to your heart's content (e.g., using the Modify button on the main window’s toolbar).  

 

Full -Text Search 

Finally, the third free tool is the Full-text Search tool, which as its name implies, lets you search your 

journal for any word, phrase, or text pattern. You can browse the search results sequentially or jump 

directly to any of the journal items found by double-clicking the item in the search results window. If 

you pause the mouse cursor over an item on the search results list, you will even see a tooltip with 

the first few sentences of the journal item to help you decide whether you want to open the journal 

item or not. 

 

 

 

 

 

 

 

 

 

 

 

 

For a more advanced search, you can open the Advanced Search Dialog. The word list you see on the 

right hand side of the dialog will update in real time as you type your search request so you will 

immediately see all similar words in your journal including the frequency of their occurrence.  

You can search for synonyms; you 

can search for words that sound 

similar to your search term, and 

much more. The product 

documentation goes into more 

detail about the advanced search 

options on this dialog. 

 

Use these buttons to browse 

the search results 

This button opens the 

Advanced Search Dialog 


